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1 Introduction

1.1 Manual Purpose

This manual is a guide to the use of the Support
Tool (Upload/Download) program which is
used with the ID5x/6x Series Fire Control
Panels.

Related Documents

This manual should be read in conjunction with
the following documents:

a. Installation, Commissioning & Configuration
Manual.

b. Operating Manual.

System Design and Planning

It is assumed that the system, of which the
ID5x/6x panel is a part, has been designed by
a competent fire alarm system designer in
accordance with the requirements of EN54
Part 14, BS 5839 Part 1: 1998 and any other
local codes of practice that are applicable.

Be aware that...

This manual is not intended to be a fire
detection system design guide and should only
be used by (or under supervision of) a qualified
system design engineer.

Cross-references (in bold
type) in this manual include
links. For example, click on

(see Section 4) to go to
that Section.
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1.2 General

System configuration files can be prepared
using any IBM-compatible PC in offline mode,
(i.e. you do not need to be connected to the
panel itself during data preparation). Only when
the system configuration file is complete does
the PC need to be connected briefly to the
panel. Then a simple operation, initiated with
a few keystrokes and taking only a few
minutes, is sufficient to program the data into
the panel.

In addition, you can initially connect your PC
to the fire control panel to read the data from
the panel - this takes only a few seconds. The
PC can then be disconnected from the panel
and moved to a more convenient place for
editing. Once editing is complete the PC is
re-connected to the panel and the edited data
sent to the panel. During the read and send
operations the panel is still functional, except
during the brief time period required for data
transfer.

The Support Tool is fully Year-2000 compliant.

Before connecting a PC to
the Panel, refer to

Section 2. Incorrect
connections could result in
damage to the comms port

of the PC.
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1.3 Hardware Requirements

1.3.1 Computers

It is recommended that the Support Tool runs
on an IBM PC-AT compatible, Pentium-class
PC, running under Windows® 9x with
16MBytes of memory or Windows® 2000/NT
with 32MBytes of memory and with Internet
Explorer 4, or later. The PC must be equipped
with at least one serial port and (preferably)
one printer port. For optimum performance it
is recommended that the PC has, as a
minimum, 32MBytes of free memory (RAM)
and 35MBytes of free hard disk space. The
PC monitor should be configured with a screen
resolution of at least 800 x 600 pixels.

If you experience any problems, contact
NOTIFIER or your computer supplier.

1.3.2 Printers

The Support Tool will allow you to print the data
files on any configured WindowsTM printer
connected to the serial or parallel port of your
PC. There are no special printer drivers in the
software and the more sophisticated printers
(e.g. some laser printers) may not operate as
expected.

Consult NOTIFIER if you experience difficulty.

Make sure a pointing
device is installed when

using the Support Tool on
a laptop.
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1.3.3 Connecting a PC to the Panel

Use a suitable data communications cable.
The panel requires a male RS232 9-way
D-type connection from the cable.

1.4 Backing Up

When installing this program on a PC, follow
the online installation procedure. Make back-
up copies of all configuration data files. Keep
the master Compact Disc in a safe place.

Always make regular
back-ups of all the data

files generated.
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2 Installation

Before either a panel configuration file can be
received by the PC or a configuration file can
be sent to the panel, a connection must be
made via the RS232 Interface connections.
Jumper links must be set appropriately. The
procedure is given in the panel’s Installation,
Commissioning & Configuration Manual (in
Section 2.8, RS232 Interface Connections).

After successfully transmitting/receiving the
panel system configuration, the PC may be
disconnected.
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3 Starting the Program
Before the WindowsTM Support Tool program
can be started, it must be installed on a suitable
computer (see Section 1.3.1 Computers).
Run the CD and follow the on-screen prompts.

During installation you are prompted to select
the installation setup language. Choose the
desired language from the drop-down menu.

Note: An alternative language can be selected
at any time after installation from a
configured list of languages (see
Section 5.4 Tools Menu).

To run the Support Tool program, either:

a. From the Start menu, select Programs/
Notifier Limited/ID5x&6x Series/ID5x&6x
Series Tool (or the path in which the
program was installed, if different), or

b. Double-click the ID50Tool.exe icon in
WindowsTM Explorer.

When the ID50Tool.exe program is opened,
the following Support Tool window is displayed:

It is NOT possible to run
the Support Tool

program from the CD.
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3.1 How to Authenticate the Support Tool

An unauthenticated Support Tool has restricted
functions. The Tools drop-down menu is
inoperable (greyed out) - except for selection
of language and VdS Compatibility mode - and
it is not possible to communicate with a panel
or change the Serial Port Setup.

To authenticate the Support Tool:

1 Start the Tool and, from the Help menu,
select the Authenticate option. The
Authenticate dialogue window is displayed.

2 Note the customer code and enter it
(together with the other requested data) on
an Authentication Request form.

Note: Authentication Request forms are
available from Notifier - phone Sales on
+44 (0) 1444 230300.

3 Fax the Authentication Request form to
Notifier on +44 (0) 1444 230888. Notifier
will supply a licence key (valid for a specific
PC only) in response.

4 On the Authenticate window, select �Enter
Licence Key�. The Licence window is
displayed.

5 Enter the supplied key into the Licence
window and select OK (or Cancel, to ignore
the authentication). When authenticated
the Support Tool is fully operational.

Note: If the Tool is installed on a different
physical OR logical hard drive (e.g. on
partitioned drives), you will have to
repeat the whole authentication procedure.
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3.1.1 Re-authentication

When the Support Tool Program licence has
less than 31 days to run, a warning is displayed
at startup (see opposite). Re-authenticate the
tool following the procedure described above.

3.2 Using the Support Tool Program

The program is very easy to use, with all
functions either selected via menus or function
keys:

a. Current selections are highlighted in
reverse video (see opposite).

b. Press the <ALT> key and use the cursor
arrows to step through the different options,
or type the underlined character from the
required function.

c. Alternatively, use the mouse to select the
appropriate function.

d. While you are editing, the Help file can be
accessed via function key F1.

The functions available under the various
menu options are described in the remainder
of this manual.

Alt
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4 Open a File/Create a New File

A new configuration file template or an existing
configuration file template can be accessed
using the standard WindowsTM �New� and
�Open� commands. These commands are
available at the top left corner of the Support
Tool startup window. Files can also be opened
by dragging and dropping onto the Tool
window.

The �New� and �Open� commands create and
load files with the extension �.udf�. If an old .udf
file is opened, the version number is
automatically updated and a �Save� request is
made.

4.1 NEW File

To create a new configuration file, either:

a. Press the �New� icon on the toolbar, or

b. Select the �New� option from the File menu.

A new blank template will be displayed (see
Section 4.3 Configuration File Template).
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4.2 OPEN File

To open a previously-stored configuration file:

a. Select the �Open� option from the File drop-
down menu to display the �Open File�
dialogue window, typically as shown at left.

Use the standard WindowsTM navigation
tools to search for and open the required
file.

or

b. Select a file from the history list. When a
file is selected from the history list a
template will be shown with the
configuration settings stored in the file.

Refer to Section 4.3, Configuration File
Template.

HISTORY
LIST
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4.3 Configuration File Template
The Configuration File template is displayed
when opening a new file (as shown below) or
a previously-stored configuration file (*.udf).
The new file template will not contain any
specific system data, i.e. it is blank, whereas
a previously-stored file contains saved
configuration data.

The Configuration File template comprises four
main areas (see illustration below):
a. Menu tool bar.
b. Command button tool bar.
c. Connection view.
d. Device list/configuration view.

b

d

a c



ID5x/6x Series Panels - Offline Configuration Manual

M
E

N
U

 T
o

o
l 

B
ar

12 997-405, Version 2.72a
March 2006

5 Menu Tool Bar

The Menu tool bar contains the following
menus:

a. File.
b. Edit.
c. View.
d. Tools.
e. Help.

The options selectable from each Menu are
described in the following sections.

5.1 File Menu

The File menu has the following options:

New Creates a blank configuration file.
Open Opens an existing configuration

file.
Save Saves the current configuration

to the file.
Save As Saves the current configuration

with a new name or to a new
file location.

Print Preview View configuration details to
print.

Print Prints the configuration data.
Printer Setup Allows change of print settings.
�History List� Lists previous configuration

files opened.
Exit Closes the current session.
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5.2 Edit Menu

The Edit menu has the following options:

Cut Device Removes the selected device,
with its details, and places it on
the clipboard.

Copy Device Places the selected device,
with its details, on the clipboard.

Paste Device Only available after either
copying or cutting information.
Inserts the contents of the
clipboard at the insertion point
or replaces any highlighted
selection.

5.3 View Menu

The View menu has the following options:

General Setup
Options Allows general setup options to

be viewed and/or changed.
Onboard Output
Circuits Allows the configuration of the

onboard circuits to be viewed
and/or changed.

Zone Text Text assigned to each zone
may be viewed and/or changed.

CBE Rules Control-by-Event (CBE) rules
associated with modules and
onboard output circuits may be
viewed and/or changed.
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5.4 Tools Menu
The Tools menu has the following options:
Send to Panel Transmits the current saved

configuration information to the
panel.

Receive from Panel
Retrieves the current configuration
data from the panel and loads
it into the PC�s memory.

Fetch Event Log/Fetch Device Data
Retrieves the event log or
device data from the panel. A
�Save As� option allows the log
or data to be saved as a .csv file.

Log Device While the Tool is connected to
the panel, this option allows a
device to be logged in real time
on the Tool (select the Sensor
or Module address, use the
slider to set the logging interval
[range 5 to 60 seconds], then
Start. The data can be saved
as a .csv file.

Serial Port Setup
Selection of this menu displays
the window at left. To assign a
serial port other than �COM 1�,
use the down arrow to display a
list of other comms port options.
Click the �OK� button to confirm
and return to the configuration
file, or �Cancel� to return without
changing the selection.

.csv = comma separated
values Excel file
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Language Presents a list of configured
languages and the �VdS
Compatibility� option. Select the
required language from the drop-
down menu (the language change
is implemented immediately).

VdS Compatibility
Changes the functionality (some
CBE defaults) to comply with the
requirements of VdS (Germany).
To ensure all relevant defaults
are set when opening a new file,
select �VdS Compatibility� first,
then open the file.

5.5 Help Menu
The Help menu contains the following options:

ID5x/6x User Manual
Displays the Offline Configuration
Manual providing appropriate
software has been installed.

Authenticate This option is only available with
an unauthenticated Support Tool.
Refer to Section 3.1, How to
Authenticate the Support Tool.

About Displays a window showing
software part and version
number, NOTIFIER�s website
address and available PC
memory. Also displayed is the
licence time remaining (in
days). See Section 3.1.1.
Press �OK� to Exit.
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6 Command Tool Bar

The Command tool bar contains eight standard
WindowsTM icons:

a. New File (Ctrl+N).

b. Open File (Ctrl+O).

c. Save File (Ctrl+S).

d. Print (Ctrl+P).

e. Print Preview.

f. Cut Device (Ctrl+X).

g. Copy Device (Ctrl+C).

h. Paste Device (Ctrl+V).

Each icon operates as in standard WindowsTM

applications. The icons are described in
Section 5.1, File Menu.

a b c d e f g h
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7 Connection View

The Connection View pictorially shows the
outputs and signalling devices connected to
the panel.

The view can be expanded (+) or collapsed (-)
as in the standard WindowsTM Explorer. To
expand or collapse click the LEFT mouse
button on the required icon (+ or -) or text header.

You can use the mouse buttons to navigate
and select options within the Connection View
as follows:

Left mouse button - Navigate

Panel Displays the Setup Options screen
in the Configuration View area.

Onboard
Outputs View the Onboard Outputs Setup

screen in the Configuration View area.

Loop View the loop device list (sensors -
default) in the Configuration View area.

Sensors (Sensor
Address) View the sensor loop device list in

the Configuration View area.
Selected device is highlighted.

Modules (Module
Address) View the module loop device list in

the Configuration View area.
Selected device is highlighted.
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Right mouse button - Options

Panel Icon Right-click on this icon to display the
following drop-down menu options:
Edit
Send to Panel (Ctrl+T)
Receive From Panel (Ctrl+R)

Edit options are: Loop Devices, Onboard Outputs,
CBE Rules or Zone Text. Refer to Section 5.2.
Send to Panel - refer to Section 15.1. Receive
from Panel - refer to Section 15.2.
Onboard
Outputs Displays the CBE Rules drop-down

menu; left-click to select �CBE Rules�.
Loop Displays a drop-down menu with

options to Add/Change or Delete
devices; also selectable from an
individual address icon.
Select �Add/Change� for Sensors or
Modules.
Select �Delete� for Sensors, Modules
or ALL Devices.

Sensors You are prompted to enter sensor
address/range, type and specified
zone. Refer to Section 11.1.

Modules You are prompted to enter module
address/range, type and specified
zone. Refer to Section 11.1.

ALL Devices
Delete option only. You are
prompted to confirm/cancel
selection. Refer to Section 11.3.
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8 Device List/Configuration
View

The device list/configuration view on the right-
hand side of the Support Tool window presents
one of the following four displays:

a. Setup Options (five tabs).

b. Onboard Outputs.

c. Sensor Device list.

d. Module Device list.

Typical Setup Options and Onboard Outputs
displays are shown at left. Typical Sensor and
Module Device lists are shown on the next
page.
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Sensor Device List

Note: This display provides access to the
�Alarm� and �Day� (Day Mode) sensitivity
fields (Section 11.1.4). Fields are also
available for the configuration of VIEWTM

sensors and other device groups except
for device type TMP (Section 11.1.4).

Module Device List

Note: This display provides access to the CBE
Range Entry window (Section 11.1.6).
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9 Setup Options

The Setup Options display enables you to edit
the panel�s Setup menu options. The display
has five tabs:

a. Panel Options. Enables you to select the
Panel Type, Set/change the Date Format,
select the Control Keys access level, select
printing modes and select the following
actions: function of Control Key 3 (VdS
only), LEDs 1H and 2C and the un-mute
function of the internal buzzer with new
alarms.

b. Site Details. Enables you to enter/edit the
Site Name and Service Telephone Number.

c. Device Options. Enables you to set/select
Device Blinking, Automatic High Test time,
Digital Input 1 function, Transmission
Device mode, FWP Input 4 Disable, Pulse
Ratio,  and Extinguishing System functions.

d. Peripheral Options. Enables you to set/
select the number of repeaters, their
protocol, and the RS232 port mode.

e. Day/Night Settings. Enables you to
activate/deactivate the Day Mode and/or
Weekend Night Mode and configure Delay
Timers.

To view the Setup Options display, select the
Panel Icon in the Connection View area on the
left-hand side of the Support Tool window; the
Device List/Configuration View area displays
the current settings.



ID5x/6x Series Panels - Offline Configuration Manual

S
et

u
p

 O
p

ti
o

n
s

22 997-405, Version 2.72a
March 2006

9.1 Panel Options

The Panel Options tab allows you to set the
following:

a. Panel Type. Highlight the type from those
available in the list. Restricts the options
available in the Support Tool to those
appropriate to the selected panel. Panel
Type is stored with the configuration and is used
to generate a warning if this is incompatible
with the panel. It is set automatically when
a configuration is received from a panel.

b. Date Format. Highlight the required format
from those listed (options are dd/mm/yyyy,
mm/dd/yyyy, yyyy/mm/dd).

c. Control Keys Require Level 2 Access.
Click the �Yes� button for access level 2, or
the �No� button for access level 1.

a b c

e

EN54-2: 7.6 - 8.6.1
Level 1 Control Key

access is NOT
compliant with

EN54.

d. Control Key 3 Mode.  Applicable to
NF-Series panels only. Key function can be
set as Transmission Device Enable/Disable
or End Delay/Evacuate.

e. Event Printing. ID51/52, ID61/62 only.
Click either �On-Demand�, if events are not
to be printed until requested at the panel�s
User Print menu, or �Continuous� if events
are to be printed when they occur.

d
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Panel Options (continued)

f. Print Format.  ID51/52, ID61/62 only. Click
the required size of characters to be printed
at the printer, either Single Height or Double
Height.

g. LED 1H Mode. The default function for this
LED is PRE-ALARM. This allows the
selection of alternative LED function of
SOUNDERS SILENCED.

h. LED 2C Mode. The default function for this
LED is PLANT ALARM. The alternative
FAULT OUTPUT: FAULT/DISABLED
function can be selected.

i. UN-mute Internal Tone. Used to control
how new alarms un-mute the internal
buzzer, i.e. new alarms occurring in zones
not previously in alarm or for any new
device going into alarm.

j. Mains Fault Delay. This can be extended
to prevent the fault being displayed
unnecessarily if the site experiences
frequent short interruptions to the mains
supply. The maximum delay is 60 minutes
(but see the EN54 warning opposite).

k. Fire Output Active LED Option. Only
available if VdS Compatibility is set. Used
to select the condition under which the
Remote Fire Output Active LED illuminates
(either transmission device tigger or return
signal).

fg

hj ki

EN54-4: 5.4
Mains fail delay MUST
NOT exceed 30 minutes.
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9.2 Site Details

The Site Details tab allows you to set the
following:

a. Site Name. Use this field to enter a site
name (maximum of 20 characters) for the
panel. The entered site name replaces the
�Status: NORMAL� message on the panel
LCD. Text is entered at the current cursor
position; use the �backspace� or �delete�
keys to erase characters.

b. Service Phone No. Use this field to enter
the phone number of the designated
servicing company (maximum of 20
characters). Alpha/numeric characters are
entered at the current cursor position; use
the �backspace� or �delete� keys to erase
characters.

a b
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9.3 Device Options

The Device Options tab allows you to set the
following:

a. Blinking. Select polled-device blinking
either �On� or �Off�.

b. Automatic Hightest Time. At a specified
time, the panel polls all devices and tests
that they can produce an alarm condition.
Place the cursor at the left-hand side of the
time field and enter the time of day (in
24-hour format) at which the test is to occur.
The cursor automatically moves to the right.
Check the �Enable� box to enable the test
(or leave unchecked if the test is not
required).

c. Digital Input 1. Select the effect when the
panel�s Digital Input 1 is activated; either
�Class Change� (all Class Change-
configured outputs will operate) or �Day
Mode Start� (Day Mode delays start).

d. Transmission Device. Applicable to
NF-Series panels only. Select the output
response of this device; either �Continuous�
(steady) or �6s Pulse� (6 second pulsed).

CONTINUED...

a b c

d
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Device Options (continued)

e. FWP 2 Output Activation. Controls
conditions under which an associated
Fireman�s Work Panel (FWP) operates the
Transmission Device-triggered output
(FWP2). Default state is to activate the
output when the Transmission Device output
is triggered. Optional state is to activate the
output when the Transmission Device
return signal (via Digital Input 2) is triggered.

f. Pulse Ratio. Select the common value for
all outputs configured as pulsing; either �1/1�
(one second ON, one second OFF) or �4/1�
(four seconds ON, one second OFF).

g. Day Mode Device Sensitivity. Set the start
and end times (24 hour-clock) at which
sensors use their �Day� preset sensitivity
level instead of their �Night� preset sensitivity
level. If the start and end times are the
same, Day Mode remains inactive. Does
not affect delays (Section 9.5).

h. Weekend Night Mode. If enabled, the
panel disregards Day Mode on the two days
of the week that coincide with the weekend.
If disabled, Day mode applies to all days.

i. Activation Delay Time. A common value
used by all Extinguishing System CBE
Rules (default 60 seconds). Use the spin
buttons or up/down arrows to select the
required time (minimum 10 seconds,
maximum 180 seconds).

CONTINUED...

f

ie

g h

Note: If an incorrect date has been entered at
the panel, Weekend Night Mode may
not coincide with the weekend.
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Device Options (continued)

j. Soak Time. A common value used by all
Extinguishing System CBE Rules (default
0 = no limit). Limits the operating period of
these CBE Rules, to prevent damage to the
extinguishing system module. Use the spin
buttons to select the required time, or
highlight the current setting and enter a new
value (maximum 999 seconds).

k. Hold Switch Operation. Highlight the
required effect of the switch upon the CBE
operation. The options are:

AHJ. While a Hold Switch is active, the
activation delay timer is reset to the pre-
programmed value (this is the default).

NYC. While a Hold Switch is active, the
activation delay timer is reset to the pre-
programmed value plus 90 seconds and
paused.

ULI. While a Hold Switch is active, the
activation delay timer continues to count
down, and pauses at 10 seconds before
release.

IRI. Hold Switch activity is ignored if two or
more zones associated with the
Extinguishing System CBE are in alarm.
Otherwise the effect is the same as ULI.

Note: When the Hold Switch becomes
inactive, the activation delay timer
restarts.

kj
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9.4 Peripheral Options
The Peripheral Options tab allows you to set
the following:

a. RS485 options:

i RS485 Protocol. Highlight the required
option:
DISABLED - disables communication
between the panel and repeater(s).

NOTIFIER - use with IDR-2A and IDR-2P
repeaters.

ARP50/RP50 - use with these repeaters.

BFT/LLT - use with these Swedish
repeaters.

THIRD PARTY - use with non-NOTIFIER
repeaters.

ii No. of Repeaters. Use the spin buttons to
select the number of repeaters installed on
the RS485 Communications link, or
highlight the current setting and enter a new
value (range 0 to 16).

iii Third Party Datalink Monitoring.
Monitoring of the RS485 Third party
Datalink can be set to �Enabled� or
�Disabled�.

iv Third Party Suspend Limit. Used to limit
the maximum time for suspending the
RS485 Third Party Protocol Datalink. Enter
a value of 1 to 300 minutes or a value of �0�
if an indefinite period is required.

a(i)a(ii)

a(iv)a(iii)
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Peripheral Options (continued)

b. RS232 options:

i RS232 Protocol. Highlight the required
protocol: a) to connect a printer at the panel�s
RS232 port; b) to connect a computer
application that supports the 3rd party protocol;
c) to connect to a modem for the
transmission of selected panel events to the
GSM telephone network.

ii RS232 Options. Highlight the required option:

If �Printer� was selected in (i) above, the
options are basic (data sent to printer at 20
characters/sec without data flow control),
XON/XOFF (software control of data flow)
or HARDWARE (control lines control data
flow - not applicable to ID50/60).

If �Third Party� was selected in (i) above,
the options are FULL or HALF DUPLEX.

If GSM MODEM was selected see next
page for details.

iii Third Party Datalink Monitoring.
Monitoring of the RS232 Third party
Datalink can be set to �Enabled� or
�Disabled�.

iv Third Party Suspend Limit. Used to limit
the maximum time for suspending the
RS232 Third Party Protocol Datalink. Enter
a value of 1 to 300 minutes or a value of �0�
if an indefinite period is required.

OR

b(i) b(ii)

b(iv)b(iii)
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Peripheral Options (continued)

If GSM MODEM was selected in (i) above
up to five contact telephone numbers and
up to five categories of panel event for
transmission can be entered here.

Notification of an Alarm, Pre-alarm, Fault
condition, panel Controls action or
Disablement status change can be selected
or any combination of them. The default
notification selection for each is: Alarm, Pre-
alarm and Fault.

With the cursor placed at the left-hand end
of the �Number� entry field, type the required
telephone number (no spaces are required
and only numeric values are accepted).

For each telephone number select the
required notification categories using the
tick boxes provided.



ID5x/6x Series Panels - Offline Configuration Manual

S
et

u
p

 O
p

ti
o

n
s

31 997-405, Version 2.72a
March 2006

9.5 Day/Night Settings

The Day/Night Settings tab allows you to set
the following:

a. Day Mode Delays. This function
automatically (unless input 1 is set to Day
Mode Start or the Day Mode Start Option is
set to Manual) enables the two-stage delay.
Set the Day Mode start and end times (24
hour-clock). If the start and end times are
the same, Day Mode remains inactive.
During Day Mode the activation or
deactivation of delayed outputs can be
overridden manually. This setting does not
affect sensor sensitivity (Section 9.3).

b. Weekend Night Mode. If enabled, the
panel disregards Day mode on the two days
of the week that coincide with the weekend
and enables the single-stage delay. If
disabled, Day mode applies to all days.

Note: If an incorrect date has been entered at
the panel, Weekend Night Mode may
not coincide with the weekend.

c. Day Mode Start Option. If Automatic is set,
Day Mode starts and ends at the times
configured in step a, otherwise Day Mode
is controlled manually at the panel.

a b

c

EN54-2: 9.1.2
Disablement and

re-enablement MUST  be
a manual operation at

access level 2.
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Day/Night Settings (continued)

d. Primary Delay Time. The Primary Delay
Timer is a common value (default
30 seconds) for all delay rules assigned to
outputs. Either use the spin buttons to
select the required time, or highlight the
current setting and enter a new value
(maximum 300 seconds).

e. Extend Delay Time. The Extend Delay
Timer is a common value (default
3 minutes) for all delay rules assigned to
outputs. Either use the spin buttons to
select the required time, or highlight the
current setting and enter a new value. If the
total delay time would exceed EN54
regulations (i.e. 10 minutes between fire
detection and activation of outputs), the
extend delay time is automatically reduced
to ensure this limit is not exceeded.

f. End Delays Option. Select the method to
end delays: Two zones in alarm or heat
detector(s) in alarm, or both options.

g. Delays Active LED Indication. Select
whether only the DELAYS ACTIVE LED is
lit or the DELAYS ACTIVE and
DISABLEMENT LEDs  for the indication of
active delays.

d e

fg
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10 Onboard Outputs

This display allows all of the six onboard output
circuits to be configured.

Each output can be assigned to a specific
output CBE Rule. The CBE Rule to which the
output is assigned can be edited.

EN54-2: 8.8
One hardware-

configurable output
MUST be configured

as a fault relay.
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EN54-2: 7.7.1
One output MUST be

configured as a
monitored sounder

output.

10.1 Configuration Option

The Onboard Outputs circuit configuration
display is used to specify the hardware output
type. This software configuration is in addition
to hardware jumper links (see the panel�s
Installation, Commissioning and Configuration
manual). The options are:

a. Sounder (SDR).

b. Transmission Device (TxD).

c. Supervised Relay (CTL).

d. Unsupervised Relay (RLY).

e. Extinguishing System Output (ESO).

f. Extinguishing System Trigger (EST).

g. Extinguishing System Non-extinguishing
Ouput (ESE).

h. Relay Output Extinguishant Module (RLE).

i. Control Output Extinguishant Module
(CTL).

For each output, highlight the required option
from those available in the list.
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10.2 Control-by-Event (CBE) Rule Number

The operation of each Onboard Output is
controlled by one of up to 64 numbered
Control-by-Event (CBE) Rules. A CBE Rule
defines a set of input conditions (e.g. fire alarm
in specified zones) that will activate all the
outputs which have the Rule Number assigned
to them.

Use the keyboard to enter the Rule Number
(or Numbers separated by commas) to be
applied to the Onboard Output.

To edit a CBE Rule, select the corresponding
� � button. The CBE Rules window is
displayed (refer to Section 12 CBE Rules).

Note: The last CBE Rule viewed on the CBE
Rule window is automatically entered
into the CBE Rule No. box when the
CBE Rule window is closed.
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11 Loop Device Configuration

11.1 Adding/Changing Device Settings

Use the scroll bar on the right-hand side of the
Device List View to scroll through the sensors or
modules. Up to 99 of each may be configured.

To select a particular device, click on any field
in the appropriate row or on the grey area to
the left (or click on the device�s icon in the
Connection View).

The following sections describe each of the
fields.

11.1.1 Description

To change the existing device
description, or enter a new one,
click within the device�s text field.
Any existing text is highlighted and
can be deleted by pressing the
<delete> key, or can be overwritten
with any character.

Click again within the �description�
field. The text highlighting is turned
off and a cursor bar is shown. Insert
new text at the cursor position (use
<backspace> and <delete> to
erase characters). The maximum
number of characters that can be
entered is 20.

To erase a word, double-click on it and then
press the <delete> key.
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11.1.2 Zone Number

To change the zone number assigned to the
device, click in the �Zone� field. The current
zone number is highlighted. It can be deleted
(i.e. set back to zone 1), or overwritten with
the desired zone number.

Sensors and input modules (except AUX) can
be assigned to zones 1 - 16. AUX input
modules can be assigned to zones 17 - 32.
Module types SDR, RLY, CTL, TxD, EST, ESO,
ESE, RLE and CTE can be assigned to any
zone.

11.1.3 Device Type

To change the device type, or add a device,
click in the �Type� field. The current type is
highlighted and a down arrow appears. Click
on the arrow to view the drop-down menu and
highlight the required type. Click to select it.
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11.1.4 Sensors - Alarm/Day

These fields allow two sensitivity levels
to be set for the selected device. The
�Alarm� sensitivity is used during Night
Mode and the �Day� sensitivity is used
during Day Mode, if this mode is
configured (see Section 9.3). To change
the sensitivity, select either the Alarm or
Day field and enter the new value (for
MULTI [MLT], VIEWTM [AVS & AVR] and
Optiplex [OPX] sensors, select the
sensitivity level from the drop-down list).

All sensors, except logical type TMP, can be
allocated to a co-operative, multi-sensing
group. The default group is �0� except for
VIEWTM sensors, which has the default group
�1�. The defaults can be edited as required
(maximum of 50 groups) and device types can
be used in any group. If sensors are required
to operate as stand-alone devices, they must
be put into group 0.

Note: If transferring a configuration from panel
software earlier than version 5.00, the
group number will be defaulted to �1�. This
must be changed to zero for all devices
that are not to be monitored using the
co-operative, multi-sensing group
algorithm.



ID5x/6x Series Panels - Offline Configuration Manual

L
o

o
p

 D
ev

ic
e 

C
o

n
fi

g
u

ra
ti

o
n

39 997-405, Version 2.72a
March 2006

VIEWTM Sensors

Click in the �Type� field and select the
VIEWTM logical type, either �AVS� (sensor)
or �AVR� (reference sensor).
The columns headed �PA� and �PD� are specific
to VIEWTM sensors only:
a. �PA� and �PD� set the pre-alarm levels
for Night and Day Modes respectively.
b. When a VIEWTM sensor is selected it is
automatically assigned to the default co-
operative, multi-sensing group �1�. If a group
contains both AVS and AVR types, the AVS�s
de-sensitise if the AVR�s detect a sudden
rise in contaminated air. If VIEWTM sensors
are required to operate as stand-alone
devices they must be put into group 0.

Optiplex Sensors

Click in the �Type� field and select the
OPX logical type. Click in the Alarm/Day
column and select one of six values
between L1 and L5; L1 being the most
sensitive and L5 the least sensitive.
Select L6 for the �Heat� only option (see
note below).

Note: Optiplex sensor L6 functionality is only
possible with panel software version
5.00, or above. Optiplex sensors must
only be used with LIB software version
9.00, or above.
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11.1.5 Modules - AUX Actions

The �Action� field applies to modules
of type AUX only. By default,
activation of these modules produces
a PLANT ALARM. To change the
effect, click in the �Action� field. The
current action is highlighted and a
down arrow appears. Click on the
arrow to view the drop-down menu,
highlight the required action, then
click to select it. Actions are:

a. PLANT ALARM.
b. Panel controls (RESET PANEL, SILENCE

SOUNDERS, MUTE BUZZER).
c. CLASS CHANGE.
d. Extinguishant system controls (ABORT

SWITCH, HOLD SWITCH).
e. FIRE BRIGADE CALLED.
Note: HOLD SWITCH has the effect selected

on the Setup Options display
(Section 9.3).

Priority Polling - Activation Time

The first 30 modules (from lowest address
upwards), restricted to types MCP, DKM, MRL,
IRL, and all AUX actions except Plant Alarm,
are added automatically to a priority poll list.
Subsequent modules are polled normally.
Auxiliary action inputs must be activated for a
sufficient period for the panel to recognise the
change. For priority-polled devices, activating
the input for 5 seconds should be sufficient.
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11.1.6 Modules - CBE Rules
Each Output Module, and some types of Input
Modules can be assigned to up to 24 CBE
Rules. Up to 64 CBE Rules can be configured.
However, if a module is assigned to more than
one Rule the range between the maximum and
minimum (base) must be 24 or less. The
currently-selected base is shown in brackets.
Default assignments are made in accordance
with the module type.
To change the CBE Rule:
1 Click within the selected module�s CBE

Rule field. The current Rule number(s) are
highlighted.

2 Click the � � button (at the right of the field)
to display the CBE Range Entry window. (If
the Base number is already set, you can
also enter the range directly, see Tip!).

3 Use the spin buttons (or direct number
entry) to set the Base CBE Rule number
(maximum 41); the window then shows 24
of the 64 Rules, starting with the Base number.

4 If activation of the module requires a Loop
Booster to operate, check the Loop
Powered Output box. A �+� is prefixed to the
Base CBE Rule number.

5 Check the boxes at the left of those Rules
to which the module is to be assigned.

To edit CBE Rules, either double-click a Rule or
click the Edit Rule button, then see Section 12.

You can enter a range of CBE
Rule numbers directly

(bypassing the Range Entry
window); e.g. 5-7,9 selects

Rules 5, 6, 7, and 9. The entry is not
recognised until you click outside of the

CBE Rule entry field.
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11.2 Adding a Range of Devices

In the Connection View area, right click on the
�Loop� icon to display the �Add/Change� menu.
With �Add/Change� highlighted, the �Sensors�
and �Modules� options are displayed.
Select either �Sensors� or �Modules�. A dialogue
window appears with fields for the device
addresses, zone number and type details.
Click in the �From Address� field and use the
keyboard numeric keys to enter the lowest
address in the range. Click in the �To Address�
field and enter the highest address in the
range.
There may already be configured devices
within the address range. If the existing
configuration data for these devices is to be
overwritten, click the �Overwrite defined
devices� check box. Leave this box blank if the
existing configuration data for these devices
is to be retained.
Use the �Zone� spin buttons to select the zone
number into which the devices will be placed.
Click on the arrow to the right of the �Type� box
and highlight the required type from the
displayed list. All added devices will be
configured with this type.
When all fields have valid information, the �OK�
button is enabled. Click �OK� to add the range
of devices to the device list.
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11.3 Deleting Devices

11.3.1 Deleting an Individual Sensor/
Module

In the Connection View, right-click on the
required individual device icon. A pop-up menu
is displayed.
Click on �Delete Sensor� or �Delete Module�
(depending upon the device type). A Confirm
window is displayed.
Click on �Yes�. The device is removed from the
device list.

11.3.2 Deleting All Sensors/Modules

In the Connection View, right-click on the �Loop�
icon. A flyout menu is displayed. Highlight
�Delete� to display the �Sensors�, �Modules� and
�All Devices� options.
Click on the required �Delete� option. The
appropriate Confirm window is displayed.

Click on �Yes�. The devices are removed from
the device list.
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12 Control-by-Event (CBE) Rules
This section applies to both Onboard Outputs
(see Section 10) and Loop Modules (see
Section 11.1.6). These are collectively
referred to here as outputs (but remember that
some types of Input Modules can be
associated with the CBE Rules).

An Onboard Output can have one CBE Rule
associated with it; a Module can have up to 24.
The Onboard Outputs or Modules controlled by
a given Rule are referred to as �assigned outputs�.

Up to 64 numbered Rules can be defined. The
CBE Rules window has 64 tabs located across
its top, each of which displays a corresponding
Rule. A typical Rule includes the following
parameters:

a. Rule Type. This defines the event that must occur (e.g. Fire, General Fault, Plant Warning, etc.) to activate
the output. Depending upon this selection, some options may be unavailable (greyed out). See Section 12.1.

b. Filter-by-Type. Two filter lists are provided; one is applicable to Fire, Pre-alarm and Fault Rule
Types only, and the other to the Extinguishing System Rule Type only. See Section 12.2.

c. Input Zones. Applicable to Fire, Plant Warning and Extinguishing System Rule Types only. This defines
in which zone(s) the Rule Type event must occur to activate the outputs. For each zone that is included
in the Rule, the condition in which the zone will activate can be modified (e.g. a delay occurs, or co-
incident alarms are required; the options available depend upon the Rule Type). See Section 12.3.

d. Control Parameters. These define the effect on the output of certain panel pushbuttons, or whether
a Fire or Plant Warning must occur in two zones simultaneously to activate the output, or whether
the Extinguishing System Rule Type will start the extinguishant soak timer. See Section 12.4.

If the Rule Type is �Device Input�, up to three devices can be selected as the input. See Section 12.5.
To select a different Rule number, click on the appropriate tab or the �Previous Rule�/�Next Rule�
buttons. Each Rule Number displays its current settings. When all edits have been completed, click
on the �Close� button to return to the configuration file.
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12.1 Rule Type

The Rule Type drop-down menu allows the
user to change the Rule Type. Select the down
arrow to display the available types, then
highlight the one that is required.

The nine Rule Types have the following effects
(may be modified by Control Parameters - see
Section 12.4):

a. Fire Rule Type. Activates its assigned outputs in response to fire alarms in specified zones (may
be modified by Zone Actions - see Section 12.3).

b. Device Input Rule Type. Activates its assigned outputs in response to input(s) from one of up to
3 specified devices.

c. General Fault Rule Type. Activates its assigned outputs in response to a general fault condition
at the panel.

d. General Pre-Alarm Rule Type. Activates its assigned outputs in response to general pre-alarms.
e. Plant Warning Rule Type. Activates its assigned outputs in response to plant alarms in specified

zones (may be modified by Zone Actions - see Section 12.3).
f. Fire Output/Transfer Rule Type. Activates its assigned outputs in response to the Fire Output/

Transfer relay being operated (i.e. General Fire).
g. Reset Rule Type. Activates its assigned outputs for 5 secs in response to a panel reset.
h. Day Mode Rule Type. Activates its assigned outputs when the panel is operating in Day Mode.
i. Extinguishing System Rule Type. Activates its assigned outputs and reads its assigned inputs

in response to fire alarms in specified zones (may be modified by Zone Actions - see Section 12.3).
j. General Disablement Rule Type. Activates its assigned outputs in response to general

disablements.

By default, Rules 1, 6 and 8-64 are set to Fire, 2 to General Pre-Alarm, 3 to Plant Warning, 4 to
General Fault, 5 to Fire Output/Transfer and 7 to Reset. However, all Rules can be edited.
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12.2 Filter-by-Type

12.2.1 Fire, Pre-Alarm, Fault Rule Types

The assigned outputs are only activated/inputs
are only read if the event occurs in the assigned
zone(s) at the configured type of input device:
a. ANY. Activate irrespective of the type of

input device at which the event occurs.
b. OTI. Only activate if the input device is an analogue

sensor (Optical, Thermal, Ionisation or Multi).
c. AVS. Only activate if the input device is a

VIEWTM sensor. Applicable only for those panel
variants that support VIEWTM (e.g. ID60, NF50).

d. MCP. Only activate if the input device is a
manual call point (not available for Pre-alarm).

e. MON. Only activate if the input device is a
monitor module (not available for Pre-alarm).

12.2.2 Extinguishing System Rule Type

The assigned outputs are only activated/inputs
are only read if the selected event occurs in
the assigned zone(s):
a. One smoke and one heat sensor in alarm.
b. One sensor and one MCP or ZMX in alarm.
c. One VIEWTM sensor and one other type of

sensor in alarm (if panel supports VIEWTM).
d. Any two devices in alarm, but must be in

different assigned zones.
e. Any two sensors in alarm.
f. Any one sensor in alarm.
g. Any one module in alarm.

FIRE RULE

PRE-ALARM RULE
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12.3 Zone Actions
For Fire, Plant Warning and Extinguishing
System Rule Types it is possible to define
which zones are included in the input to the
Rule. If a zone is included, its action can be
modified - the modifying conditions vary with the
Rule Type as shown opposite. The options are:
a. ON. The zone is included in the Rule. An

alarm in this zone will activate the output
immediately in continuous mode.

b. DELAYED. The zone is included in the Rule.
An alarm in this zone will activate the output,
after a delay (see Section 9.3), in continuous
mode. Not available for Fire Rules if Two Zone
is selected. Extinguishing System Rules
default to delay. The following does not apply
to Extinguishing System Rules: If a Day
Mode period is set (see Section 9.5), the
delays must be activated manually during
this period. Also, delays are then NOT
active outside of the Day Mode period.

c. COINCIDENCE. The zone is included in the
Rule. The output will activate immediately
in continuous mode when there are two
alarms in this zone (one alarm has no effect).

d. PULSED. The zone is included in the Rule.
An alarm in this zone will activate the output
immediately in pulsed mode (see
Section 9.3). However, the pulsed mode is
overridden by a continuous alarm if an alarm
occurs in any zone which is included in the
Rule and for which PULSED is not selected.

e. OFF. The zone is not included in the Rule.
CONTINUED...
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Zone Actions (continued)

Click the mouse in the required zone�s
�Condition� box and select the required option
from the drop-down menu.

To set ALL zones to ON or OFF, click on the
�Set All ON� or �Set All OFF� button respectively.

Zones 1 to 16 are configurable when the Rule
Type is Fire or Extinguishing System. Zones
17 to 32 are configurable when the Rule Type
is Plant Warning.
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12.4 Control Parameters
If allowed by the Rule Type, the operation of an
output assigned to the Rule can be further defined
by Control Parameters. These are selected by
check boxes. Options unavailable for the current
Rule Type are greyed. The options are:

a. Evacuate. Activates assigned outputs
when the END DELAY/EVACUATE
pushbutton is operated at the panel.

b. Silence. Silences assigned outputs when
the SILENCE/RESOUND pushbutton is
operated at the panel. If this option is not
selected, the outputs will only turn off (after
being activated) when the panel�s RESET
pushbutton is operated.

c. Interruptable. Ends any delays when the
END DELAY/EVACUATE pushbutton is
operated at the panel. If this option is not
selected, delays cannot be interrupted
except by another qualifying alarm
condition that turns the output on.

d. Two Zone. Applies to the Fire and Plant
Warning Rule Types only. Restricts
assigned outputs such that they do not
activate until two of the input zones included
in the Rule have detected alarms.

e. Class Change. Activates assigned outputs
in conjunction with a configured input via
Digital Input 1 (see Section 9.3).

f. Enable Soak Timer. Applies to the
Extinguishing System Rule Type only. The
Rule starts the extinguishing module timer.

EN54-2: 7.11.d
Configured delays

MUST be set to
interruptable.
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12.5 Device Inputs

If the Rule Type is Device Input, the assigned
outputs are activated when the input from one
of up to three pre-defined input devices
becomes active. For each device:

1 Click on the arrow to the right of the �Device
Kind� box to display the device type options:
Sensor, Module or Not Used. The latter
option allows fewer than three devices to
be included in the Rule. Highlight to select
the appropriate option.

2 Use the spin controls to the right of the
�Address� box to select the Sensor or
Module address. Only those addresses
already configured on the loop (see
Section 11) are available. The device type
is displayed but this is not editable.
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13 Zone Text

Display the Zone Text window either from the
View menu, or by right-clicking the panel icon
in the Connection View and selecting �Edit /
 Zone Text� from the pop-up menu.

All 32 zones are listed in an uneditable �Zone�
field. Click in the �Text� field to the right of the
zone and enter the zone name (maximum
20 characters). Any existing text is highlighted
and can be overwritten, or can be deleted by
pressing the <delete> key. When all edits are
complete, click on the �Close� button.

To clear all zone text in the Zone Text window,:

1 Click on the �Clear All Zone Text� button. A
Confirm window is displayed.

2 Click on �Yes�. All zone text fields become
blank.
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14 Saving a Configuration File

To store a configuration file, use one of the
following methods:

a. SAVE. Saves an updated file with existing
name and location. To Save, click the �Save�
button on the Command Tool bar or select
the �Save� option in the �File� menu.

b. SAVE AS. Saves a new or updated file, with
new name and/or location. To Save As,
select the �Save As� option in the �File� menu.

Use the standard Windows® navigation tools
to select the required directory. Enter the
required file name and click on the �Save�
button. The configuration file is automatically
given the extension �.udf�.

Save changes dialogue window

Closing a file which has unsaved changes
automatically displays the �Save changes�
Confirm window. Click on the �Yes� button. If
the file already has a name, the changes are
saved to disk, otherwise the �Save As� window
is displayed to allow a name to be entered.

Make regular saves to limit
the amount of data lost due

to computer problems.
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15 Communications with the
Panel

Configuration data can be sent to or received
from the panel. Before any data is sent to the
panel, the panel�s memory lock jumper (see
panel manual) must be set open. When the
data has been successfully transferred, the
jumper must be closed. It can remain closed
while data is received from the panel.

Configuration Transfer

To transfer data, the Data Transfer Lead must
be connected between the PC and the panel.
Ensure the lead is connected to the correct
COM port. If this cable is not connected, the
window shown at left is displayed.

Ten attempts are made to connect the PC and
panel. To abort these attempts, click on the
�Abort� button.

After the tenth attempt at making a connection,
the display changes to that shown at left.
Either:

a. Fit the Data Transfer Lead and then click
on the �Retry� button, in which case ten more
attempts are made to connect the PC and
panel, or

b. Click on the �Abort� button to end the
connection process.
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15.1 Send Data to Panel

Ensure the panel�s memory lock is open (see
panel manual), then select the Tools menu and
click on the �Send to Panel� option. The
�Configuration Transfer� window prompts for a
passcode.

Click in the �Passcode� box and use the
numeric keys to enter the level 3 numeric code.
Click on the �Start Transfer� button to send the
data. The �Send to Panel� window is displayed.

The progress of the data transfer is shown by
a bar and by a message. The number of
attempts to complete the transfer is also
displayed. An �Abort� button is provided - see
Section 15.3, which has important information
regarding use of �Abort� while sending data.

When the data transfer is complete, the
Configuration Template View is displayed.

Issue 1 of the panel
software is not passcode

protected.
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15.2 Receive Data from Panel

From the Tools drop-down menu, select the
�Receive from Panel� option. When the PC is
receiving data from the panel, the �Receive
from Panel� window is displayed.

The progress of the data transfer is shown by
a bar and by a message. The number of
attempts to complete the transfer is also
displayed. An �Abort� button is provided - see
Section 15.3.

When the data transfer is complete, the
Configuration Template View is displayed.

It is also possible to receive the event log or
device data, and to view device data in real
time. Refer to Section 5.4.

Communications Failure

If there is a communications failure, e.g. the Data
Transfer Lead becomes disconnected, the PC
makes 10 attempts to receive the data. After the
tenth attempt, the window shown at left is displayed.

To continue with attempts to receive the data,
i.e. if you are going to reconnect the Data
Transfer Lead, click on the �OK� button. The
prompt is re-displayed after every 10th attempt
to receive the data. To stop attempting to
receive data, click on the �Abort� button.
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15.3 Abort Transfer

If the �Abort� button is operated on the �Send
to Panel� window or �Receive from Panel�
window while a data transfer is in progress,
the �Abort Transfer� prompt is displayed.

To stop the data transfer, click on the �Yes�
button. Complete configuration file sections
already sent to the panel will be saved and
updated in the panel (see warning opposite).

To continue with the data transfer, click on the
�No� button.

Aborting transfer while
sending data to the panel

may leave the panel in an
indeterminate state,

because all data received
prior to the abort will have
been processed and stored.
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16 Printing

The following options are provided:

a. Print Preview. Used to ensure that the
selected pages will print correctly. See
Section 16.1.

b. Print. Used to print the selected pages. See
Section 16.2.

c. Printer Setup. Used to configure the printer.
See Section 16.3.

Note: These options are not available if there
are no printers installed on your PC.

All these options can be accessed from the
�File� drop-down menu. The �Print Preview� and
�Print� options can also be accessed directly
from icons on the Command bar (see
Section 6).
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16.1 Print Preview

This option displays the Print Preview window.
The window is divided into three areas:

a. Navigation Pane.

b. Command Bar.

c. Preview Page view.

Navigation Pane

The Navigation Pane is displayed down the
left-hand side of the Print Preview window. It
is used to select the data that appears in the
Preview Page view. To view printable data, click
on the relevant thumbnail (each is sub-titled)
in the Navigation Pane; the selected thumbnail
outline is emboldened.

To select the data for printing via the print icon,
click on the corresponding thumbnail. If further
thumbnails exist above or below those
currently displayed, use the up/down arrows
or slider bar to view them.

a b c
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Print Preview (continued)

Command Bar

The Command Bar is displayed across the top
of the Print Preview window.

a c e

b d f The options available from the Command bar are:

a. Page Selector. Use the spin controls to
select page 1 or 2 (if applicable) of the
current view selected by the thumbnails.

b. Print button. Click to print the page(s)
associated with the current view.

c. Zoom to Fit button. Click to resize the page to
fit the entire area within the Preview Page view.

d. Zoom to Width button. Click to resize the
page to fit the width of the area within the
Preview Page view; part of the page may
then be hidden.

e. Maximise Preview button. Click to resize
the Print Preview window to fit the PC�s
screen. Second operation returns the Print
Preview window to its original size.

f. Close button. Click to exit from the Print
Preview window.
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Print Preview (continued)

Preview Page View

The Preview Page view displays the page
selected from the Navigation Pane.
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16.2 Print

This menu option displays the Print Selection
window (note that this option does not have
the same effect as using the Print icon on the
Print Preview Command Bar).

The window has one check box for each
printable view. Check each view that is to be
printed, then click the �OK� button to print the
checked views. By default, all boxes are
checked.

16.3 Printer Setup

This option displays the Print Setup window.

Click on the arrow at the right-hand side of the
�Printer� box to display a drop-down list of
available printers (if more than one is
available). Highlight and click on the required
printer.

Use the spin buttons to display the required
number of copies in the �Copies� box.

Click the �OK� button to accept this setup.
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